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About the Quick Start Guide
AcclaimIP is a powerful software product containing 155 million patent documents updated from 
dozens of different data sources.  It has been under development since 2010 with several updates 
each month.

Mastering the software can take some time, but most users find they can get a good degree of 
competence in just a couple of hours, especially if they have a solid foundation in patents.

This guide is not a step-by-step tutorial, but rather designed to get you up-to-speed with the software 
as quickly as possible.  Each page covers one topic and gives you an overview of key capabilities of 
each major function, and how/where to access them.

You’ll find with a little trial and error; you’ll be running like a pro in no time.

For a more detailed user manual go to ….

http://help.AcclaimIP.com
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Which prior art was 
referenced by each 
examiner.
How the art was used 
(e.g., general, novelty, 
obviousness, etc.)
If a family counterpart 
was in fact cited by the 
examiner of the patent 
investigated.
Ranking of uncited 
references by their 
potential relevance to the 
patent being considered.

ACCLAIMIP’S PATENT 
PENDING UNCITED 
PRIOR ART FEATURE 
SHOWS…
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Windowing Layout
Purpose-built windows 
perform specific tasks such 
as review a set in the Search 
Results or present a specific 
patent in the Doc Details.

Grouped Paging
Windows such as the Doc 
Details, Search Results, PDF, 
PAR and Figure Viewer are 
tied together so they all 
page at the same time.

Tangential Research
You won’t lose your place if 
you decide to investigate 
something that comes up.  
New windows appear.

Window Locking
To save real estate, some 
windows are replaced with 
new content every time they 
load.  To prevent this, click 
the Lock icon and a new 
window will open.

Application Login & Layout

Login to AcclaimIP by clicking Login in the upper right of the AcclaimIP.com website.  Your login ID is your email 
address.  An administrator will give you a temporary password which must be reset the first time you login.

The design of AcclaimIP resembles a desktop interface, resembling an operating system rather than a typical 
web app. This layout is conducive to multitasking and exploring various research avenues, which are essential 
for most search projects. Moreover, AcclaimIP can adjust to any screen size.

Layout

Login



Quick Search
Basic form for initiating 
keyword searches and 
advanced Synax.

Fielded Search
Basic form for initiating 
common searches.

Query Builder
Advanced query builder 
allowing for use of all 
field codes and nested 
clauses.

Number Search
Paste up to 5000 
document numbers.

Patent Owners
Easy form for finding 
patents owned by 
patent owners.

Natural Language
Returns related 
documents from a 
pasted paragraph of 
text.

Search Strategies
Canned forms targeted 
at specific search 
strategies.

Search History
Remembers searches 
performed and 
documents viewed. 
Search History is saved 
to the current Project.

Search Tabs

Which prior art was 
referenced by each 
examiner.
How the art was used 
(e.g., general, novelty, 
obviousness, etc.)
If a family counterpart 
was in fact cited by the 
examiner of the patent 
investigated.
Ranking of uncited 
references by their 
potential relevance to the 
patent being considered.

ACCLAIMIP’S PATENT 
PENDING UNCITED 
PRIOR ART FEATURE 
SHOWS…
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Search Window
Searches are started within the Search Window.  Open the window by clicking 
the Search icon on AcclaimIP’s desktop.  The top of the window shows a row of 
eight tabs for searching using vaious methods.  You’ll notice that the Search 
Options field-set is consistent across many of the tabs where you set your basic 
search parameters.    

Initiate your searches from the Search window, but once a search is run, all 
subsequent refinements are done in the Search Result Window’s refine panel.

Family Search Mode
Turn on to search patent 
families as a single record.

Search  Tabs
Select tab to find 
your favorite 
search form.

Hide/Show
Simplify the 
Search Options 
Field-set.

Search Options
Parameters set 
here flow through 
to refine panel in 
Search Results.

SearchHelp 
Window

Keywords & 
Syntax
Type keywords, 
field codes, 
Boolean 
operaters and 
advanced syntax.

Copyright 2020 Anaqua, Inc.

Run Search & 
Open Search 
Results.

Syntax, Field Code 
Guide & Code 
References.
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Search Result Window
Once a search is initiated, the results appear in the Search Result window.  The search result window contains all 
the tools for refining searches, reviewing documents, analyzing results with charts, exporting and setting alerts.

Search Result Grid
Drag & drop columns in any order.  Click column headers to display up 
to 80 different data columns.  Drag column widths.  Sort by clicking 
header row.  Double-click to invert the sort order.  Click gear icon in 
upper right corner to set default grid preferences.

Your Search

Filters

Modify your 
original search 
syntax at the 
top of the 
Refine Panel

Filter results 
by any of the 
38 filters.  
Select gear 
icon to modify 
filter display 
settings.  An 
unlimited 
number of 
filters can be 
used based 
on your 
custom field 
data.

Switch to Family 
Search ModeToolbarExpand all Rows

Toggles results between 
document and family-
centric modes.

Menus with additional 
functions such as charting, 
exports, and expander 
row modes.

Opens expander rows 
displaying either biblio or full 
figures depending on mode 
selected in View menu.

Grid Columns
Drag & Drop column 
order.  Display up to 80 
columns.  One click 
sorting.  Set default 
preferences.

Expander Rows
Change the content 
displayed in expander 
rows  from biblio to 
figure view from the 
View menu.

Filters
38 pre-programmed 
filters and unlimited 
custom filters can be 
displayed.  Change the 
order by clicking the 
gear icon.

Set Analysis
Analyze the search 
results set with charts 
found in the View menu.  
Cluster search results 
with concept mapping.  

Exports
Export up to 70 
columns of data, bulk 
PDFs.  Set column 
order.  Create column 
profiles for easy recall.

Quick Start Guide
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Expander Row Content
The expander rows in the Search Result grid can be opened by clicking the  in the first column.  The content 
can by customized with either the Biblio data, along with the representative image, or the full set of images 
associated with each patent document displayed.  When searching in Family Mode, expander rows display grid 
listing the family members.

Hover Mouse to Zoom 
Mouse-over any thumbnail 
images and see a dynamic 
zoomed in view.  Double-click 
to open full size image in its 
own window.

Multi-Mode Expanders 
Switch from Bibliographic 
to Image View in the 
Expander Rows.  Toggle 
Ctrl-I to switch modes back 
and forth.

Opening Expander Rows
Open expander rows 
individually by clicking the  
icon in the far-left column.  
Click the  in the header to 
expand the entire grid.

Legacy Image Viewer
Choose View>Image View to 
see the legacy image viewer.  
It’s still handy for some figure 
reviewing projects.

Select Expander Row View

Use of Space

No. Pages of Images

Hide/Show Abstract

Switch between Bibliographic 
and Image views. 

Create even 
more space by 
collapsing the 
refine panel. Displays the full count of the 

number of pags of images 
indicating if you need to scroll right.

Design patents do not have abstracts.  
Free up space by optionally hide/show 
abstract in figure position one.

Infinite Scrolling 
Review thousands of figures with 
infinite scrolling option enabled 
in the pagniation controls.

Quick Start Guide
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Charts & Visualizations
Patent data can be analyzed using 16 base chart types, which can be modified to tell the precise story you are 
creating with the data.  Select the Charts menu from the Search Result window.  Chart the set by modifying the 
options in the ribbon bar or the chart’s refine panel.

Edit Charts
Editing options are found in 
both the ribbon, the refine 
panel.  Chart colors are 
modified by clicking on the 
legend label below the x-
axis.

Chart Types
Chart types like bar, bubble, 
map etc. vary based on the 
options you choose.

Data Types 
Chart by 16 unique data 
types found in the top 
menu bar of the charting 
window.

Smart Chart Exports
Export from the hamburger 
menu in all standard 
graphics formats.  Data 
exports are context sensitive 
and include supporting data 
on some charts.

Modify Charting Parameters

Modify Labels

Select the specific parameters you 
want to chart from the tool ribbon.

Titles and axes have default labels 
which vary based on the chart run.  
Modify the labels to add clarity to 
your charts.

Multi-Series

Export Options

Click the  icon to add a second 
series.  Modify just one parameter 
such as assignee name in the 
second series.

Export chart graphics and/or data 
from the hamburger menu.  Multi-
series charts like these shown 
export all the data comprising the 
entire chart.

Quick Start Guide
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Document Details Window
The Doc Details window displays all the details printed on the patent as well as related data including family 
(simple and extended), legal events, file wrapper, citations, rejections and other data in up to 15 tabs.

Tabular Details
Drag & drop taps in your prefered 
order.  Choose View>Split to view 
two tabs simultaneously.
.  

Navigation

Figure 
Thumbnails

Paging patents 
follows the parent 
search.  Related 
windows like Figure 
Viewer, Reports, and 
PDFs paginate  in-
line with details 
window.

Hover mouse 
to view larger 
version, or 
double click to 
open full-scale 
image viewer.

Find Similar Patents

Modal Patent Score

Save to Folder

Options to use natural 
language or term extraction 
techniques are presented.

Patents are scored with an 
algorithm which measures each 
patent’s strength from a series of 
well-understood data points.  Prior 
Art Score assess prior art risk based 
on known prior art references.

Quickly save documents to a 
folder using the drop down.  
The last folder used is always 
in focus.

Compact View
Designed to put as 
much information in 
front of you as 
possible.  Choose 
View>Split to view two 
tabs at once.

Tombstone Data
The key identifying data 
always remains at the 
top of the window 
keeping you focused 
on the document.

Tabular Details
Patent Details are held 
in 15 sub-tabs.  
AcclaimIP remembers 
the last tab in focus.  
Drag & drop into 
preferred order.

Patent Score
Score widget gives an 
overall score, broken 
down into Technology, 
Legal and Citation 
Components. 

Quick Paging
Browse large lists of 
patent details by 
paging with the arrow 
keys.  AcclaimIP 
remembers which tabs 
are in focus.

Quick Start Guide

Up to 5 Patent Reports
Use-case-specific reports which 
support  specific decision points 
such as annuity payments, foreign 
filing, prosecution analytics, 
Orange Book, and a general 
overview. 
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Case Level
All citations are indicated 
by the current 
representative document 
for each case cited or 
citing.)

Consistent
All publications derived 
from one filing have 
identical citation profiles.

Direct & Family Cites
Citations are displayed as 
those citing(ed by) a 
specific matter/case, and 
another tab citing(ed by) 
the entire familly.

Prior Art Scores
Reverse citation record is 
scored for uncited prior 
art from 0 to 5.

Meta Data
Citations are decorated 
with Category and 
Rejection codes to 
indicate how each 
citation was used.

Non-Patent Literature 
NPL are in their own sub-
tabs and also gathered at 
the direct and family 
level.

Query-able Data
Use the Field Code Guide 
to find the queries to 
search for specific 
conditions in the citation 
record, such as all my 
patents cited by a 
specific assignee .

Patent Citations
AcclaimIP has the world’s most advanced citation data which includes displaying 
both the direct and family citation records in both directions.  Each citation is 
decorated with meta data which indicates how the citation was used.  Uncited 
references are scored based on the likelihood they may impact the patent claims.

Quick Start Guide

Forward and Reverse 
Citations are found 
on their own tabs on 
the DD window.

Counts on tabs hint at 
the contents inside.  
Tooltip on tab 
describes the counts.

Citations are divided 
into Direct and 
Family Citation tabs.

DC icon indicates the 
family reference is 
also on the Direct 
Citation list.

Uncited family 
references are scored 
from 1 to 5.  Tooltip 
explains each score.

Expander rows shows 
which family member(s) 
cited the case.

Citations decorated 
with Category, 
Rejection, and 
Phase Codes.

View citation list in main 
grid for further refinement 
or charting.  Modal button 
contains export options.

All patents are given 
a Prior Art Score 
from 0 to 5.



One Click from DD
A single click opens the 
modified Search Results 
window which supports 
unique tasks for refining 
similar patent searches. 

Similar Document 
Explorer
Panel with dedicated 
features for modifying 
your natural language 
search.

Required Terms
Enter specific terms, 
strings, or advanced 
syntax to refine your 
search results.

Change Source Text
Switch from claim-to-
claims matching to full text 
with one click.

Prior Art Only
Limit returned results to  
those with priority dates 
earlier than the source 
document.

Class Fingerprint
Automatically inserts a 
special query that 
influences the results by 
the source document’s 
CPC and IPC classification 
profile.

Max No. Documents
Specify the maximum 
number of results you 
want the search engine to 
return.

Search Tabs Find Similar Patents

Two Options from the Find Similar Menu

Similar Document Explorer Refine Panel

Finding similar patents combines language, keyword extraction, and classification 
techniques to return the best possible list of potentially related, similar or prior art 
patents.  With one click, AcclaimIP gives you excellent matches, and the tools you 
need to help the search engine refine the related art you are looking for.

Find Similar Button
Both options give you 
the same ability to 
refine the search after 
the initial results have 
rendered.

Similar Document 
Explorer

Class Fingerprint
Applies a unique class 
query to your natural 
language search 
identifying which patents 
are also classified most 
similar to the source 
document.

Special refine panel 
appears for interacting 
with the search engine.  
Common tasks such as 
requiring specific terms, 
or refining with advanced 
syntax tells the search 
engine what criteria 
matching documents 
must have.

Quick Start Guide
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Folders & Saving Searches
Folders contain list of patents or saved searches.  Create folders from the Research Folders icon on AcclaimIP’s 
desktop.  Share folders with your colleagues who have AcclaimIP seats in the same account.  Archive older 
folders that are no longer being used.  Save patents to folders from either the Search Results window or the 
Document Details window.

Up to 5000 Folders
Create up to 5000 folders 
that can contain up to 50K 
patents and saved 
searches.

Shareable
Folders can be shared with 
other users in your 
account.  Give them read 
only or read/write access.

Searchable
Open a folder and search 
within using the refine 
panel.  Or use the folder ID 
along with the RFID field 
code to enhance your 
advanced syntax.

Charting From Folders
Select one or more folders and 
click the Chart button to chart 
their contents in all avaliable 
charts in AcclaimIP’s charting 
package.

Quick Start Guide

Select a folder(s), then 
click the Chart button to 
chart the contents of 
one or more folders.

Import directly, or add 
an entire list from the 
Search Results window.

Create new folder 
by clicking button 
on toolbar.

Refer to Research 
Folder ID with RFID field 
code to search within a 
folder using advanced 
syntax.

Nesting folders is a nice 
way to organize your 
projects.

Save searches to the same 
folders that contain your 
lists. Searches appear with 
a floppy disk icon.

Select a folder name 
from the drop down, 
and click Save on the 
Doc Details toolbar.
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Portfolio Management Reports
Five reports surface the data to help you evaluate patents at specific decision points during the patent lifecycle.  
Patent Analytis Report, Foreign Filing, Prosecution Analytics, Annuity Decision and Orange Book reports cover all 
major decision points during the patent lifecycle.  Reports available from the Reports drop down menu on the 
Document Details window. 

Patent Analytis
Basic report covering 
key aspects for 
understanding a 
patent an its impact.

Patent Analytis
Basic report covering 
key aspects for 
understanding a 
patent an its impact.

Prosecution Analytics
Discloses prosecution 
history and key stats on 
art unit and examiner 
to determine the best 
path forward.

Prosecution Analytics
Discloses prosecution 
history and key stats on 
art unit and examiner 
to determine the best 
path forward.

Foreign Filing
Data specifically 
designed to help you 
determine where to 
file foreign 
counterparts.

Foreign Filing
Data specifically 
designed to help you 
determine where to 
file foreign 
counterparts.

Annuity Decision
Information disclosed 
supports renewal 
payment decisions for 
your global portflio.

Annuity Decision
Information disclosed 
supports renewal 
payment decisions for 
your global portflio.

Orange Book
For pharma patents, 
the reports 
consolidates OB data 
with patent data using 
helpful visualizations.

Orange Book
For pharma patents, 
the reports 
consolidates OB data 
with patent data using 
helpful visualizations.

Concise Patent Summary

Share
Each report contains a 
patent summary designed to 
give you a brief overview of 
the patent in focus. Reports are designed 

to be shared with 
users, even if they 
don’t have AcclaimIP 
seats such as your 
patent attorneys.

Share  from the  
report itself or  share 
thousands using the 
Export function on 
the Search Result 
window.

Report Specific Information
Each report has use-case 
-specific information to 
support key decision points 
during the patent lifecycle.

Quick Start Guide
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Forward and Reverse Rejection Data 
Forward rejections are special citations when an examiner explicitly references a document in their novelty 
(102) or obviousness (103.n) arguments.   AcclaimIP parses these data from examiner office actions. 

102 and 103.n Rejections
Forward and reverse 
rejections are marked as 
either 102 or 103.n, where 
the “n” denotes the order in 
which a document was 
referenced in an 
obviousness argument.

Office Action Documents 
AcclaimIP associates 
competitors’ office actions 
with your patents when 
they are referenced in a 
rejection argument.  One 
click to review the 
examiner’s decision

Query Syntax
38 unique field codes are 
included so you can 
determine the who, what, 
when and result of 
rejection references.

Exports & Alerts
Unique Excel export is can 
be downloaded from the 
Rejections tab.  It giving you 
all pertinent data for both 
the blockiing and blocked 
applications.

On the Doc Details Window
Foward and reverse rejection details 
are found in a tab in the Document 
Details window.  Data displaying the 
rejection event, its type, mailroom 
date and results are shown.  Click 
the O/A link to read the examiner’s 
rejection argument.

Rejection Field Codes
38 available field codes 
and instructions on how 
to use them are found in 
the Field Code Guide.

Rejection-Based Search Strategies
To help create queries using advanced syntax, we’ve added 
specific Search Strategies to cover most common rejection 
queries which are included this form shown, as well as one 
based on a Mad-Lib style.

Quick Start Guide
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Complete Metrics
19 charts and 
visualizations bring all 
relevant prosecution 
statistics to bear to 
support successful 
patent prosecution.

Guide Decisions at 
Every Decision Point
The data you need is 
queued for various 
phases of prosecution 
from responding to the 
first office action, 
requesting an interview, 
filing an RCE or initiating 
an appeal. 

Multiple Points of 
View.
Compare your 
examiner’s statistical 
history to that of the art 
unit, the classification, 
tech center.

Share with Your 
Clients & Colleagues
Share reports via a PDF 
document or a link 
directly to the report 
reader application.

Prior Examples
Find examples of 
applications that 
overcame similar 
objections from the 
same examiner.  

Access in AQX
Beginning with AQX 
10.2, prosecution 
analytics are integrated 
directly.

US Prosecution Analytics

One Click to Start

Prosecution Splits

Make more informed decisions during your patent prosecution with integrated 
prosecution statistics for your examiner, art unit, tech center, CPC class and firm.  
Prosecution analytics are available in one click from any application, or from the 
Search Result window from the Analyze>Prosecution Analytics menu.

Prosecution 
Timeline
Key prosecution 
events are recored 
on an easy-to-read 
timeline

Quick Filters

Examiner & Art Unit 
Statistics

19 Key Statistics

View statistics from 
multiple points of views 
with just one click.

Evaluate the historic 
likelihood of success of 
your examiner or art unit.

Guide your decisions with 
supporting analytics at every stage 
of the prosecution process

Quick Start Guide
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Projects, Search History and Combining Searches
The widget at the top of the AcclaimIP desktop is called the Projects gadget, which contains controls to save 
your search history and documents viewed to a specific project which can be recalled later.  Essentially, projects 
provides a way to manage your search history into separate baskets and improves management of your 
production research.

Easily Accessible Controls
Create projects, switch 
between projects, and 
access search history from 
one convenient gadget in 
the center of the desktop.

Better Manage Work
Organize your work by 
referencing AQX case IDs 
and instructions associated 
with each project.

Recall Later
Update research projects 
with current patent 
information by recalling 
your previous research and 
re-running the searches.

Combine Searches
Saved searches are numbered 
and can be recalled by referencing 
the number.  You can also use 
standard Boolean operators when 
recalling searches.  For Example.  
S:39 NOT S:38.

Quick Start Guide

Create new 
project

Toggle between 
default project and 

last updated project.
Static indicator that 

your search activity is 
being recorded.

Click to view 
documents viewed 
in current project.

Expand/collapse 
project details

The Search History window is 
tied to the active project and 
displays only those searches 
and documents viewed in 
the project that is loaded.  The modal Search 

button includes the 
ability to export 
search history.

Seaches are 
numbered and can be 
recalled using the “S:” 
field code.  Eg. S:35.

Minimize project 
gadget to taskbar.

Drop down to select and 
load a different project.
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Private Data and Custom Fields
Custom Data Fields allow users to annotate patents with private data.  A robust security and authorization 
model determines who has access and whether they are read-only or can edit and export private data.  Clients 
use custom fields to collect data from SMEs, as well as to display data captured in AQX and PattsyWave.

Workflow Integrations 
Custom Field data are 
integrated seamlessly in the 
workflow on the Doc Details, 
Search Results, Filters, 
Exports, and Field Codes.

Eight Field Types 
Define fields for text, 
integers, decimals, dates, 
URLs, tags, Booleans, 
integer-select, and string-
select.

Import and Export
Export private data from the 
normal Export window.  
Import data using the import 
utility located in 
Start>Custom Fields>Upload 
Custom Data. 

Permission Model
Alerts are easiest to review 
using the workflows 
presented in the 
application.  Alerts are 
processed on Tuesday 
mornings ET.

Sortable in Search Result Grids

View, Annotate or Edit from Doc Details

Export Private Data 
Display an unlimited number of private data 
fields in the grid.

Depending on the permissions set, users can view and edit data 
which is useful for marking and annotating patents during any 
research project.  Data is constantly indexed, allowing managers to 
monitor progress of specific research tasks.

Collect data in AcclaimIP, then export 
results to a spreadsheet for reporting.

Custom Field Codes

Custom Filters

Define field codes for 
querying with ranges, 
Empty/notEmpty, and 
wildcards just like 
standard data. 

Filters are 
automatically available 
for all custom fields 
you set up. 

Quick Start Guide
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Alerts
Alerts were rebuilt from the bottom up in 2019 and include 44 specific events relating to a patent’s legal record, 
maintenance fees, and file wrapper updates.  In addition, we added email distribution lists, review workflows 
and the ability to create watch lists based on single documents or entire patent families.

Access Alerts
Open the Alerts window 
from the purple tab on the 
right edge of the 
application.

44 Event Triggers 
Trigger events include new 
publications, global legal 
events, US file wrapper 
events, and forward and 
reverse rejection events.

Integrated into Workflow 
On the Search Result and 
the Doc Details windows, 
notice an alert button with 
options for appending to 
an existing alert or 
establishing a new one.

Email Distribution Lists
Send alerts to your 
colleagues by adding them 
to distribution lists. Emails 
are sent via a white-listed 
service.

Alert on Private Data
By alerting on changes to data 
stored in custom fields, you can 
configure alerts to enable any 
number of workflows including 
tagging experts to review 
patents.

Alerts Window
The Alerts window displays each 
alert in a bar chart.  Click a bar to 
drill into the Search Results 
displaying that week’s hits.  Click the 
History button to review previous 
week’s matches.  Click the Edit icon 
to make changes to your alerts.

Email to Self/Colleagues
Click the Email Distribution 
tab to email weekly alerts 
results to yourself or your 
colleagues.

Edit/Create Alerts

Base Query

Family Expansion

Patents will match when they match both 
the base query and the specific trigger event.

Turn on to match new publications in 
matching families even if the family member 
itself is not an explicit match.

Quick Start Guide
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Dashboards
AcclaimIP includes four unique dashboard layouts to analyze competitors, specific technologies, law firm 
activity, and law firm competitive analysis.  Access dashboards by clicking on the IP Strategy Dashboards icon on 
AcclaimIP’s desktop.  Create dashboards in AcclaimIP, then syndicate them to AQX users or share them with 
other users in your account.

Dashboard Management
Dashboards are organized 
by type, then alphabetically 
in tabs in the left-most 
panel.  Double-click any 
dashboard title to view.

Integrated with AQX
Dashboards can be viewed 
in AQX.  First login to AQX, 
then open AcclaimIP via 
SSO and create dashboard.  
Select “Expose in AQX” 
when defining the 
dashboard.

Drillable Charts and Lists
Dashboards report 
summary content.  Click 
any chart element to review 
the specific patents that are 
represented.

Shareable
Share to your entire rhelm by 
cliking “Quick Share” or give full 
access to specific individuals by 
right-clicking the dashboard 
name in the West panel.

Export Graphics

Special Dashboard Features

Refine View

Make selections
Hamburger menu in left 
panel gives options for 
creating new and editing 
existing dashboards.

Quick Share:  Shares dashboard as read only with 
all users in your account.
Use as Benchmark:  Appears as a benchmarkable 
dashboard when viewing.
Expose in AQX:  Not shown.  SSO users who login 
via AQX have the option to show the dashboard in 
AQX.

Use the flyout refine 
panel to change the 
data displayed in each 
dashboard element.

Refinement options vary 
depending on the chart 
you modify.

Benchmark Competitors

Select another dashboard 
definition for a comprehensive 
comparison.

Quick Start Guide



SSO Hotlinks

Find Related Art

From the Views menu login to AcclaimIP via 
SSO, AcclaimIP opens Alerts, Dashboards 
or a Matrix landscape with one click.

Click the Find Similar button to 
open AcclaimIP and return a list of 
related patents and applications.  
Further refine in AcclaimIP using 
AcclaimIP’s refinement tools.
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Single Sign-On (SSO)
Log into AQX, and with 
one click you can open 
your instance of 
AcclaimIP.  SSO simplies 
integration of widgets 
and access to AcclaimIP.

Dashboards
Monitor your 
competition (or yourself), 
specific technologies or 
law firm performance 
with integrated 
dashboards.

Snapshot Analytics
Quick analytics of 
citations, competitors 
with similar patents and 
patent score.

Analytics Report
All 5 decision point 
analytics reports are 
available from AQX’s 
patent reference screen. 

Third-Party Patents
Patents can be exported 
from AcclaimIP in 
formats compatible with 
AQX’s import formats.  
Go to Export>AQX 
Exports from the Search 
Results window.

Find Similar
From either a patent or 
invention record, one 
click links to AcclaimIP 
and returns a list of 
similar patents.  Often 
used for quick knock-out 
patentability research.

AQX Integrations with Public Data from AcclaimIP

Integrated Reports

Integrated AcclaimIP Dashboards

AcclaimIP is integrated with AQX to smoothly link users to AcclaimIP or access 
various data and visualizations without ever leaving AQX.  

Set up dashboards for your entire team in 
AcclaimIP, and access them from the “IP 
Strategy” gadget on your ANAQUA home 
page.

Access All 5 Reports

One-Click to Patent Details

Click the Analytics button to open a 
window displaying Snapshots, Patent 
Analysis Report and Prosecution 
Analytics.

An icon next to the patent and/or 
application number opens the 
specific document in AcclaimIP.

Quick Start Guide
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Analyzing EPO Publications and Validations
European grants are displayed with parenthetical country codes indicating where they were validated.  The 
colors indicate the current status of each validated state.  Details are found in the Legal tab which is broken into 
two sub-tabs.  The Events tab contains the full legal event record.  The Validation Data summarized just the data 
related to status.

Intuitive
Just check the country codes 
and their colors to determine 
where the EP is currently in 
force.  Red indicated once 
enforceable but currently dead.

Seachable
20 field codes available for 
searching EP validatioin 
data found in the Field 
Code Guide.  Search 
Playbook for EP Validations.

Full EPO Legal Events 
Along with summary of 
events related to the EP 
validations, the Events tab 
contains the full set of 
searchable EP legal events.

Charts & Dashboards
Chart EP patents by their 
validated jurisdictions and 
their status get get a full 
picture where a patent family 
is in force.  

Quick Start Guide

EP grants show the 
jurisdiction in which it 
was validated and the 
current status.

Verbose legal events 
are found in the 
Events tab.

Direct link to case at 
the European Patent 
Register.

EPO legal events related 
to status and validations 
are summarized in their 
own tab.

Color-coded columns 
indicate the type of data 
presented.

EP patents can be 
charted by their 
coverage and status in 
the charting package 
and on the dashboards.
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